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Chapter 1: Welcome to WinPager

1.1 What is WinPager

The Winpager module is designated a legacy module in IGSS V9. There will be no further devel-
opment on this module, only bug fixes.
The module is still included for reasons of backward compatibility.

The alternative to Winpager is Notifier (previously AMS). Notifier has all the features of Winpager and
more. The 7T recommendation is thus that you use Notifier.

WinPager is an IGSS module that gives the possibility to send out alarms to a mobile phone or a personal
pager. The operator who receives the alarm message on his/her mobile phone can then acknowledge the
alarm via the mobile phone. The operator does not have to be on site to acknowledge the alarm.

WinPager dials out alarms to the operators in defined time spans, for example during the weekend.
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Chapter 2: Importing Settings from Older Versions

2.1 Step 1. Import Settings from Older Version

In IGSS32, version 5.1 and newer versions, theWinpager settings are stored in an .xml in the con-
figuration’s root folder. The file is named:

[MyConfiguration].winpager.xml

Show picture

In IGSS32, version 2.0 up to version 5.0, the settings were stored in the Windows Registry. When you
install IGSS version 7.0 on a PC, where one of those versions already exist, the Registry settings from the
old version are copied to the Registry branch of IGSS version 7.0.

Show picture

If the older version is not on the same PC where you install IGSS v6.0

1. On the PC with the old version, open the Windows Registry editor by selecting Start à Run and type Regedit.

Important: Before making changes to the registry, make a backup copy. Refer to the Windows
Registry editor help for details.

2. Select the Registry branch called

HKEY_LOCAL_MACHINE\SOFTWARE\7-Technologies\IGSS32\
[IGSS Version number]\Winpager

F.ex. for IGSS v4.1 the branch is named:

HKEY_LOCAL_MACHINE\SOFTWARE\7-Technologies\IGSS32\
V4.01.00\Winpager

3. In the File menu, select Export.

4. Save the file with a meaningful name, f.ex. V4.1Winpager Settings.reg

5. Open the file in a text editor, f.ex. Notepad.

6. Press CTRL + H to replace the old version number with V6.00.00 as shown below.

Show picture

../../../../../Content/main_95_myconfig_winpager_xml_winpager_settings_file_.htm
../../../../../Content/main_95_myconfig_winpager_xml_winpager_settings_file_.htm
../../../../../Content/main_95_the_winpager_settings_in_the_igss_v6_registry_branch.htm
../../../../../Content/main_95_the_winpager_settings_in_the_igss_v6_registry_branch.htm
../../../../../Content/main_95_replace_version_number_in_reg_file.htm
../../../../../Content/main_95_replace_version_number_in_reg_file.htm
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7. Click the Replace All button.

Tip: All Registry keys are now renamed to \…\…\V6.00.00.

8. Save the file on a USB stick, CD or other storage media.

9. On the IGSS version 6.0 PC, import the settings as follows:

l In the Windows Registry editor, select File, then Import.

l Select the .reg file and click Open.

Show picture

You should now see this message confirming that the import was successful.

Show picture

Result: The settings have now been imported into the IGSS version 6.0 Registry branch.

10. Go to the next step to activate the settings inWinpager.

Activate the settings from the older version

1. OpenWinpager.

2. In the File menu, select Import Settings, then From Registry.

3. Press CTRL + S to save the settings in the [MyConfiguration].winpager.xml file.

../../../../../Content/main_95_import_winpager_settings_from_older_version_to_registry.htm
../../../../../Content/main_95_import_winpager_settings_from_older_version_to_registry.htm
../../../../../Content/main_95_winpager_settings_have_been_successfully_imported.htm
../../../../../Content/main_95_winpager_settings_have_been_successfully_imported.htm
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Chapter 3: Getting Started with WinPager

3.1 Getting started with WinPager

The Getting started example configures the WPMAPI service, sets up operators, sets up an operator group,
creates a time schedule for a normal work week, and activate the alarm processing.

To fully configure WinPager, the following steps have to be performed:

1. Import Settings from an Older Version

2. Install Service Providers

3. Configure the Service Providers

4. Define Operators and Groups

5. Create a Time Schedule

3.2 Step 1. Import Settings from Older Version

In IGSS32, version 5.1 and newer versions, theWinpager settings are stored in an .xml in the con-
figuration’s root folder. The file is named:

[MyConfiguration].winpager.xml

Show picture

In IGSS32, version 2.0 up to version 5.0, the settings were stored in the Windows Registry. When you
install IGSS version 7.0 on a PC, where one of those versions already exist, the Registry settings from the
old version are copied to the Registry branch of IGSS version 7.0.

Show picture

If the older version is not on the same PC where you install IGSS v6.0

1. On the PC with the old version, open the Windows Registry editor by selecting Start à Run and type Regedit.

Important: Before making changes to the registry, make a backup copy. Refer to the Windows
Registry editor help for details.

2. Select the Registry branch called

../../../../../Content/main_95_myconfig_winpager_xml_winpager_settings_file_.htm
../../../../../Content/main_95_myconfig_winpager_xml_winpager_settings_file_.htm
../../../../../Content/main_95_the_winpager_settings_in_the_igss_v6_registry_branch.htm
../../../../../Content/main_95_the_winpager_settings_in_the_igss_v6_registry_branch.htm
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HKEY_LOCAL_MACHINE\SOFTWARE\7-Technologies\IGSS32\
[IGSS Version number]\Winpager

F.ex. for IGSS v4.1 the branch is named:

HKEY_LOCAL_MACHINE\SOFTWARE\7-Technologies\IGSS32\
V4.01.00\Winpager

3. In the File menu, select Export.

4. Save the file with a meaningful name, f.ex. V4.1Winpager Settings.reg

5. Open the file in a text editor, f.ex. Notepad.

6. Press CTRL + H to replace the old version number with V6.00.00 as shown below.

Show picture

7. Click the Replace All button.

Tip: All Registry keys are now renamed to \…\…\V6.00.00.

8. Save the file on a USB stick, CD or other storage media.

9. On the IGSS version 6.0 PC, import the settings as follows:

l In the Windows Registry editor, select File, then Import.

l Select the .reg file and click Open.

Show picture

You should now see this message confirming that the import was successful.

Show picture

Result: The settings have now been imported into the IGSS version 6.0 Registry branch.

10. Go to the next step to activate the settings inWinpager.

Activate the settings from the older version

../../../../../Content/main_95_replace_version_number_in_reg_file.htm
../../../../../Content/main_95_replace_version_number_in_reg_file.htm
../../../../../Content/main_95_import_winpager_settings_from_older_version_to_registry.htm
../../../../../Content/main_95_import_winpager_settings_from_older_version_to_registry.htm
../../../../../Content/main_95_winpager_settings_have_been_successfully_imported.htm
../../../../../Content/main_95_winpager_settings_have_been_successfully_imported.htm
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1. OpenWinpager.

2. In the File menu, select Import Settings, then From Registry.

3. Press CTRL + S to save the settings in the [MyConfiguration].winpager.xml file.

3.3 Step 2. Install Service Providers

WinPager has to be told what delivery services to use. This is done as follows:

1. Select Service Providers ® List of Services. The dialog box below appears.

2. Set a check mark in the WPMapi (Simple MAPI) (wpmapi.dll) service provider and clickOK.

For the full list of service providers currently available, click here.

Remember to check each service that you want to use on the list of services.
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3.4 Step 3. Configure the Service Providers

The configuration of the selected service provider is done in the following way:

1. Select Services Providers ® Settings…. The Settings for Loaded Services dialog box appears.

2. Since we only selected one service provider there only is one tab in the dialog box. Make adjustments so that your
dialog box looks like the one shown below.

3. Click OK.

A detailed description of each service provider is given in the section Service Providers.

3.5 Step 4. Define Operators and Groups

In this step we define three operators and put them in a group called plant surveillance.

1. Select Operators ® Edit…. The Edit Operators dialog box appears.

2. Click Add Single… to add an operator to the list of operators. The Edit Operator dialog box appears.
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3. Enter the following data for the first operator:

Name: John Doe
Description: Average user of WinPager
Service: WPMapi (simple MAPI)
Service
Address:

SMTP:johndoe@averageuser.com

(If you want to test the mail settings enter your
own mail address)

Alarm Fil-
tering:

Min: 5

Max: 10

For the remaining two operators only enter different names, description and service address as
shown below.

Name: John Doe jr.
Description: Son of John Doe
Service Address: SMTP:johndoejr@averageuser.com

Name: John Doe jr. I
Description: Son of John Doe jr.
Service Address: SMTP:johndoejrI@averageuser.com

3.6 Step 5. Create a Time Schedule

In this step we create a weekly calendar for all the operators. The calendar will consist of the time periods
when no operators are available at the plant.

1. Select Calendars ® Weekly…. TheWeekly Calendars dialog box appears.

2. Click Add… to add a weekly calendar to the list of weekly calendars. The Edit Weekly Calendar dialog box appears.

3. Enter the following data for the calendar:

Name: Not at plant
Description: No operators at the plant
Alarm Filtering: Min: 5

Max: 10

4. Click Add… to add time periods to the calendar. The Edit Weekly Period dialog box appears.

5. Enter the following data:
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Start Time: Friday, 16:00
Stop Time: Monday, 06:00
Primary: John Doe
Backup: John Doe jr.
Reference: John Doe jr. I

Note: To define the start and stop time you must click the Push to define button.
When setting the role of the operators drag and drop them to the wanted priority.
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Chapter 4: Scenarios of Use

4.1 Overview of Scenarios

The Scenarios of this help file are examples of how to set upWinPager. It starts very simple with defining
service providers, operators and a weekly calendar. Then it becomes more and more complex defining oper-
ator calendars, creating filters, and using holidays in the calendars and more. We recommend that you
start with the simple scenario.

Click the relevant scenario for a step-by-step procedure:

Simple Scenario

Operator Groups Scenario

Holidays & Special Periods Scenario

Operator Calendars Scenario

Acknowledging WinPager Alarms Scenario

Control Objects with SMS Scenario

Changing Calendar via SMS Scenario

4.2 Simple Scenario

This is a simple scenario, taking you through the basic steps when setting up a Siemens M20 GSM modem.

The scenario contains the following:

l Loading and setting up the Siemens M20 GSM modem

l Setting up 1 operator

l Setting up 1 weekly calendar

 To go to the next step click the Next button.

4.3 Operator Groups Scenario

This scenario is an expansion of the simple scenario. We create 4 more operators and some operator
groups.

The scenario goes through the following:



- 16 -

IGSS V9, User Guide

l Creating 4 operators

l Creating 3 operator groups

l Create a weekly calendar for the operator groups

 To go to the next step click the Next button.

4.4 Holidays & Special Periods Scenario

This scenario is an expansion of the Operator Groups Scenario. We now expand the calendar to reach
beyond the standard week, taking holidays and special periods into account.

The scenario goes through the following:

l Creating 3 holidays

l Creating 1 special period

 To go to the next step click the Next button.

4.5 Operator Calendars Scenario

This scenario is a further expansion of the Holidays & Special Periods Scenario. We now expand the cal-
endar to reach beyond the standard week, taking holidays and special periods into account.

The scenario goes through the following:

l Creating 3 operator calendars and making them default

 To go to the next step click the Next button.

4.6 Acknowledging WinPager Alarms Scenario

In this scenario we use theWinPager configuration from the operator calendars scenario.

The scenario goes through the following:

l Edit an alarm text in the Definition program.

l Changing the alarm priority for the operators Op2, Op3, Op4 and Michael Piers

l Manually make the object go into alarm state

l Acknowledge the alarm and see the effect onscreen

 To go to the next step click the Next button.
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4.7 Control Objects with SMS Scenario

As we know already, Winpager will allow an operator to acknowledge an alarm, if a dial-in service is ena-
bled. But in some cases, the operator will also know exactly how to regulate the process to correct or mini-
mize the effect of the alarm he received on his cell phone.

In that case, you can set up Winpager to allow specific phone numbers to control specific objects in the con-
figuration.

In this scenario, you will learn how to:

l Send a command to a digital object (p1)

l Change the setpoint of an analog object (t1)

l Control multiple objects with one SMS message (both objects above)

Note: You can control the following object types via SMS: Analog, digital, counter and table objects. String
objects are not supported.

The scenario is based on objects found in the IGSS Demo configuration.

4.8 Changing Calendar via SMS Scenario

In this scenario we expand theWinPager configuration of the IGSS demo configuration.

The scenario goes through the following:

l Create an ovl file.

l Check that the CalendarObject is set up correct, on the calendar tab inWinPager.

l Change theWinPager calendar via sms.

If you use another configuration than the demo configuration, click here to learn how to create the calendar
object.

To go to the next step click the Next button.

../../../../../Content/main_95_creating_the_calendar_object.htm
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Chapter 5: Service Providers

5.1 Service Providers

This section provides detailed information about the WinPager service providers.

The functionality of WinPager is modularized into a number of service providers. Each service provider con-
sists of a DLL file which implements the functionality offered by the service provider and one or more DLL
files with the language resources for the service provider.

Two basic types of services are available: Delivery services and Dial-in services. The job of a delivery
service provider, consisting of services for dialing out alarms, is to deliver the alarm messages to the oper-
ators while a dial-in service provider enables the operators to acknowledge alarms from remote locations.
Before using WinPager you have to specify which service providers to be used as described previously in
step 1 of the getting started procedure.

For detailed information about the currently supported service providers, click one of the topics below.

Services for Dialing Out Alarms

Services for Acknowledging Alarms (Dial-in Services)

5.2 Show alarm on service communication error

For the Siemens M20/MC35/TC35 Terminal service, it is possible to get an alarm when there is a service
communication error. This predefined alarm is included in every new IGSS configuration you create. The
alarm number is 97, alarm priority 5 and the alarm text is by default: "Winpager communication error".

Two preconditions must be fulfilled to receive the alarm in the Alarm List:

1. In the Settings dialog box on the General tab, the check box Show alarm on service communication error must
be enabled. To activate this dialog box, open the Preferences menu and select Settings or press CTRL + G.
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2. A station object for the station to which the Siemens modem is connected must be present in the IGSS configuration.

Create the station object for reporting the alarm

l If you use the dead man's button functionality on this station, you must create a dead man's button object. This same
object will report the service communication error. Click here to read how you define the Dead man's button object. If you
only need to report the service communication error, follow this procedure.

1. In Definition, create a standard analog object with the exact same name as the station. The station name is the one
you assigned in System Configuration. In this case it is IGSSServer_1.

2. In the object properties dialog box, click the Edit Mapping tab and disable all atoms of the object. The service com-
munication error functionality is integrated in IGSS and does not require an alarm atom on the object.

3. ClickOK and install the configuration.

l The new analog object, called IGSSServer_1 in this case, will now show an alarm if there is a communication error with the
Siemens modem.

def.chm::/def_tips_monitor_the_operator_stations_dead_man_s_button_.htm
def.chm::/def_tips_monitor_the_operator_stations_dead_man_s_button_.htm
def.chm::/def_tips_monitor_the_operator_stations_dead_man_s_button_.htm
def.chm::/def_tips_monitor_the_operator_stations_dead_man_s_button_.htm
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Include the modem in the system overview diagram

7T recommends that you include the modem in the system overview, so that you can easily see if there is a
communication error. In the diagram below, the picture of the modem will start flashing with the red alarm
color.
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5.3 Dialing Out Alarms

Services for Dialing Out Alarms

The service providers send messages to specific devices. The general principle of operation for all the cur-
rently available services is identical: A WinPager service connects to a messaging center and hands over
the message that should be delivered. The messaging center is then responsible for sending the message
to it's final destination (i.e. a mobile phone) by a radio link or other media.

If the WinPager service fails to deliver the message to the messaging center a retransmission will normally
be initiated. But even though a message has been delivered to the messaging center there is no guar-
antee, that the message will reach the paging device - the most frequent cause of error being that the pag-
ing device has been turned off. Only the SMS services will be able to detect this last type of error occurring
in the connection between the messaging center and the device.

Click on any of the topics below for information about the configuration of the available services.

Service Description

Generic GSM Terminal SMS service

Siemens M20/MC35/TC35 SMS service

TDC SMS SMS service

Telia Minicall Paging service

WPMapi (Simple MAPI) Fax and E-mail service

Generic GSM Terminal

The Generic GSM Terminal is a hardware device for GSM communication. It can be considered as a type of
hybrid between a traditional modem and a cellular phone. It connects to the serial port of the PC just as
any ordinary modem. But instead of sending messages through a traditional telephone line, the device
transmits SMS messages directly via its own small antenna to the nearest mast in the cellular network.
Since the device operates directly on the cellular network through a SIM card, a GSM services provider sub-
scription is required.

From an IGSS point of view, there are advantages to be gained with this solution. Because payment is
made to the GSM service provider for the actual transmission of SMS messages, these receive the highest
delivery priority of all SMS messages handled. Quicker receipt of alarm messages on the operator's cellular
phone is the result. Alarm messages don't get bogged down in the cellular network because of low priority
status.
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The available settings for the Generic GSM Terminal are as follows:

Modem Commands:

Load
from

Select which set of modem commands that should be loaded, depending on the type of modem you’re using.
There are two sets of commands; for the Siemens M20 modem and for the Westermomodem. The modem com-
mands are loaded from a txt file. Click here to see an example of a txt file.

Message Delivery:

Try to send... The total number of times the service should try to send the message in case of any errors.

SMS Center Access:

SIM PIN code The PIN code for the SIM card in your GSM terminal.

Siemens M20/MC35/TC35 Terminal

The M20/MC35/TC35 Terminal is a hardware device from Siemens for GSM communication. It can be con-
sidered as a type of hybrid between a traditional modem and a cellular phone. It connects to the serial port
of the PC just as any ordinary modem. But instead of sending messages through a traditional telephone
line, the device transmits SMS messages directly via its own small antenna to the nearest mast in the cel-
lular network. Since the device operates directly on the cellular network through a SIM card, a GSM serv-
ices provider subscription is required.
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From an IGSS point of view, there are advantages to be gained with this solution. Because payment is
made to the GSM service provider for the actual transmission of SMS messages, these receive the highest
delivery priority of all SMS messages handled. Quicker receipt of alarm messages on the operator's cellular
phone is the result. Alarm messages don't get bogged down in the cellular network because of low priority
status.

Important: For this service it is possible to get a service communication error in the Alarm List. Read
more here.

The available settings for the Siemens M20/MC35/TC35 Terminal are as follows:

Modem Commands:

Initialize Terminal Initialization of the modem. ATE0+CMGF=1 resets the modem to factory defaults and disables
command echoing.

Initiate Call AT+CMGS= make the modem dial a number.

Reply String sent by the modem when a data connection with the SMS center has been established.

Message Delivery:

Try to send... The total number of times the service should try to send the message in case of any errors.
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SMS Center Access:

Phone Number The phone number for the SMS central. Do only enter a phone number if you want to use another SMS central
than the one defined on SIM card.

SIM PIN code The PIN code for the SIM card in your Siemens M20/MC35/TC35 terminal.

TDC SMS / Siminn (UCP)

This service is used for sending SMS messages to mobile phones using an UCP gateway, default is set to
the Danish GSM network operator TDC Mobil. A SMS message can contain alphanumerical characters.

Note: otocol used by this service is identical to the ERMES Universal Computer Protocol (UCP) which is
used by a large number of network operators in Europe. Specifically the SMS message transfer operation
code 30 is used. Check with your local GSM network operator if they are compatible with this service.

The available settings for the TDC SMS service are as follows:

Modem Commands:

Initialize
Modem

Initialization of the modem. AT&FE0 resets the modem to factory defaults and disables command
echoing.

Make Call Make the modem dial a number.
Connect Reply String sent by the modem when a data connection with the SMS center has been established.
Escape Escape command to interrupt the modem and make it go into command mode.
Hangup Make the modem terminate the call.
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Message Delivery:

Try to send... The total number of times the service should try to send the message in case of any errors.

SMS Center Access:

Phone
Number

Phone number of the TDC SMS center's modem access points. Prefix with '0W' or '0,' if dialling via a PBX.

User ID Used to identify the sender of a message. Only used if the gateway supports user ID.
Password Password associated with the used user ID.
SMS Oper-
ation ID

The SMS operation ID defines the type of operation performed. There are 3 types of operations to per-
form:

01: Call input operation

30: SMS message transfer operation

51: Submit short message
Confirmation
of ...

With this option checked, a confirmation is required from the SMS center saying that the SMS message
has been delivered to the mobile phone - otherwise a retransmission of the message will be initiated. If
this option is not checked, successful delivery of the message to the SMS center is sufficient.

Telia Minicall

This paging service is used for sending messages to Minicall pagers via the Telia paging network.

A Minicall message can contain alphanumerical characters.
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Modem Commands:

Initialize
Modem

Initialization of the modem. AT&FE0 resets the modem to factory defaults and disables command
echoing.

Make Call Make the modem dial a number.
Connect Reply String sent by the modem when a data connection with the SMS center has been established.
Escape Escape command to interrupt the modem and make it go into command mode.
Hangup Make the modem terminate the call.

Message Delivery:

Try to send... The total number of times the service should try to send the message in case of any errors.

Service Center Access:

Phone
Number

The phone number of the Telia Minicall modem access point (PAD). Prefix with '0W' or '0,' if dialling
via a PBX.

Sender ID Your Minicall subscriber number for sending messages.
Password Your Minicall subscriber password.

WPMapi (Simple MAPI) (wpmapi.dll)

Introduction

The simple MAPI functionality is included as a service just like the other modem based services. The name
of the service is WPMapi, which is an abbreviation of “WinPager Mail Application Programmable Interface”
(MAPI being Microsoft’s invention).

Note:WPMapi service can only be used if Microsoft Outlook is installed on your computer.

Activating the MAPI service

To use the service, you simply select it in the List of Services dialog box, and then restart Winpager for
the change to take effect. After this, it is now possible to define an operator to use this service in the “Oper-
ators” dialog box. You simply select the WPMapi service, and as service address, you type the operators e-
mail address or fax number. Note that the format for these addresses must be entered in the format spec-
ified by Microsoft. Following are examples of the most commonly used services:

Note: The specification of the recipient type followed by a colon before the actual address.

SMTP: johndoe@yourcompany.com An e-mail address

FAX: 12345678 A Fax number

MS: Network/Postoffice/MailboxA Microsoft Mail or Exchange address
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Microsoft Mail notes

For the Microsoft Mail address a few things should be noted: The “Mailbox” in the example is the user’s mail-
box. This name is usually known, but the “Network” and the “Postoffice” are usually not, since they are
never used by the normal MSMail user. To figure out a user’s full address, you can just double-click that
user’s name, either in a mail to or from that user, or in the postoffice address book. When you do that, a
dialog box will appear telling you the Network, Postoffice and Mailbox of that user. Now it should be trivial
to format the address as shown above. For the Exchange server, the full address can be found by double-
clicking the name in the address book using Outlook and switch to the “E-Mail Address” page in the prop-
erties dialog box.

Important notes

l The WPMapi service relies on a functioning MAPI mail client software being installed and running on the machine where
Winpager is running, configured with the mail services you will be using. This client could typically be Windows Mes-
senger or Outlook.

l Once the alarm is delivered to the MAPI interface, Winpager will consider the alarm delivered even though the mail or fax
never reaches the recipient. This is because a delivery failure will get back to the sending mailbox, and this mailbox will
NOT be checked by Winpager, just the mail client on the machine. So, to increase the reliability of alarms sent by MAPI, a
new operator should at least be tested using the test operator facility before being trusted, this will at least catch spelling
mistakes in the recipient address. For a description on testing an operator, see below.

l The default number of attempts Winpager will try to deliver an alarm to MAPI is 3, but it will probably not make much
sense to try more than once anyway. If Winpager fails to deliver the alarm to the MAPI interface, it is most likely due to a
configuration error, or the client is not running. In that case, it will definitely not work the second time either! In that case,
it might be better to save a few seconds of retrying a lost cause, and move on to the backup operator. This is unlike the
usual modem-based services, where “coincidence” can prevent an alarm from getting through the first time, like occupied
line, temporarily failing line, etc.

Test Operator Function

In the Operators dialog box, there is a Test ! button. Use it to test an operator by immediately sending a
test alarm to that operator. At first the operator – or group – must be selected in the list. If you have con-
figured the log settings, you can see the status of the alarm being sent by closing the dialog box after press-
ing the Test ! button and look at the Winpager window.

5.4 Acknowledging Alarms

Services for Acknowledging Alarms (Dial-in Services)

The dial-in services make it possible from a remote location to either dial into WinPager with a touch tone
telephone or send an SMS into WinPager to acknowledge previously received alarms.

Click the topics below for details.

Acknowledging with touch tone telephone

Acknowledging with SMS

../../../../../Content/main_95_acknowledging_with_touch_tone_telephone.htm
../../../../../Content/main_95_acknowledging_with_touch_tone_telephone.htm
../../../../../Content/main_95_acknowledging_with_touch_tone_telephone.htm
../../../../../Content/main_95_acknowledging_with_touch_tone_telephone.htm
../../../../../Content/main_95_acknowledging_with_touch_tone_telephone.htm
../../../../../Content/main_95_acknowledging_with_sms.htm
../../../../../Content/main_95_acknowledging_with_sms.htm
../../../../../Content/main_95_acknowledging_with_sms.htm
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If only one modem is available for use with WinPager, the dial-in and the delivery services have to share
the modem. With this setup it will, of course, not be possible to dial into WinPager at the same time an
alarm is being sent by one of the delivery services. Whenever the alarm(s) has been sent, the dial-in serv-
ice will continue to monitor the modem and answer any calls.

If calling WinPager when an alarm is being sent, the caller will probably just hear a busy tone. After hang-
ing up and waiting a short while, the modem should be available to the dial-in service again and the call
into WinPager can be completed. If concurrent dial-in and delivery are required, at least two modems have
to be used.

Click on any of the topics below for further information about the supported dial-in services.

Dial-in (ABP modem)

Dial-in (Voice modem)

Dial-in (Siemens M20/MC35/TC35)

Dial-in (GSM)

Dial-in (ABP modem)

This dial-in service uses a special DTMF-modem from the Danish company ABP TeleTech.
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The available settings for the Dial-in (ABP modem) service are described below:

Modem Control:

The ABP modem is not configurable by software, and therefore the only configurable parameter is the
number of rings to wait before answering the phone. For further details see the description of the '# Rings'
parameter for the Dial-in (Voice modem) service.

Dial-in (Voice modem)

This dial-in service uses a standard voice modem (actually there is no single common standard when deal-
ing with voice modems).

The available settings for the Dial-in (Voice modem) service are described below:

Modem Control:

Initialize
Modem

Initialization of modem. AT&F resets the modem to factory defaults. Note: The modem should not be set into
auto answer mode (e.g. by the command ATS0=1). The dial-in service will explicitly instruct the modem
when to answer the phone.

Set
Voice
Mode

Set the modem into voice mode.

Answer
Call

Make the modem answer an incoming call.

# Rings The minimum number of times the phone must ring before WinPager answers the call. Increase this number
if the modem is sharing the phone line with a fax machine or other equipment. Keep in mind when setting
this number, that most modems does not report the exact number of actual phone rings. Setting this
number to e.g. the value '2' will probably not make WinPager answer the phone before ring number 3. (the
actual number of rings seems in general to be larger than the number reported by the modem).

Hangup Make the modem disconnect a call.
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Event Detection:

(Strings sent by the modem to the dial-in service when specific events are detected)

Ringing String sent by the modem, when it detects a call.
Call Received String sent by the modem when a voice connection has been established.
Busy String sent by the modem when it detects a busy tone.

Acoustic Feedback:

(Commands to generate sounds as feedback to the caller)

Greeting Sound to play when the dial-in service is ready for the caller to enter an alarm number.
Success Sound to play when the alarm with the number entered by the caller has been sucessfully acknowledged in

IGSS.
Failure Sound to play in case of an error (the alarm could for some reason not be acknowledged).

Copy Modem Commands from Template:

To simplify the configuration of the voice modem all the modem commands can be copied from a predefined template.
Currently only three templates exist (see figure below) but they should cover most voice modems on the market. For
each template either (#V) or (+V) indicates on which of the twomajor classes of voice modem commands the tem-
plate is based. Select the most appropriate template and fine tune the commands by hand if needed.
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Dial-in (GSM)

The available settings for the Dial-in service are described below:

Modem Control:

Load
from

Select which set of modem commands that should be loaded, depending on the type of modem you’re using.
There are two sets of commands; for the Siemens M20 modem and for the Westermomodem. The modem com-
mands are loaded from a txt file. Click here to see an example of a txt file.

SMS Center Access:

Phone
Number

The phone number for the SMS central. Do only enter a phone number if you want to use another SMS cen-
tral than the one defined on SIM card.

SIM PIN
code

The PIN code for the SIM card in your GSM terminal.

Using *.ovl files

Click here to learn about the use of *.ovl files.
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Dial-in (Siemens M20/MC35/TC35)

The available settings for the Dial-in (Siemens M20/MC35/TC35) service are described below:

Modem Control:

Initialize Ter-
minal

Initialization of the modem. ATE0+CMGF=1 resets the modem to factory defaults and disables com-
mand echoing.

SMS Center Access:

Phone
Number

The phone number for the SMS central. Do only enter a phone number if you want to use another SMS cen-
tral than the one defined on SIM card.

SIM PIN
code

The PIN code for the SIM card in your Siemens M20/MC35/TC35 terminal.

Using *.ovl files

Click here to learn about the use of *.ovl files.
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Chapter 6: Operators

6.1 Operators

An operator inWinPager is the person who receives alarms sent byWinPager. The operator will then
take the necessary action for a given alarm. If the alarm is less critical, it can be acknowledged from a
remote place, by sending an SMS or by calling up a modem. An operator can only have one service
assigned for dialing out alarms, but all the dial-in services can be used for acknowledging alarms.

For each operator you can define a personal calendar, to learn more about operator calendars, click the link
below

You can define groups of operators, giving the advantage of a faster setup of calendars. To learn more
about operator groups, click the link below.

For each operator you can select a filter, so that the specific operator only receives relevant alarms, to
learn more about filters, click the link below.

Operator Calendars

Operator Groups

Filters

6.2 Operator Groups

One or more operators can be organized in groups. A group is created by assigning operators a role. Three
types of roles can be defined: Primary, Backup and Reference. The operator role is used byWinPager to
control the dial-out processing of alarm messages. Click the topics below for details.

Primary Operators

Backup Operators

Reference Operators

6.3 Operator Calendars

The operator calendar is specific for the operator and is used to give a more flexible calendar system, i.e.
when operator schedules overlap. The operator calendar is very similar to a weekly calendar, but it is
assigned to the individual operator.

The operator calendar has the lowest priority of all the calendars.

The active operator calendar is the one that has the same name as the active weekly calendar. This way
you can have multiple weekly calendars with associated operator calendars.

../../../../../Content/winpager_primary_operators.htm
../../../../../Content/winpager_primary_operators.htm
../../../../../Content/winpager_backup_operators.htm
../../../../../Content/winpager_backup_operators.htm
../../../../../Content/winpager_reference_operators.htm
../../../../../Content/winpager_reference_operators.htm
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6.4 Filters

In the Filters dialog box you define the filters to apply to theWinPager alarms. The functionality is sim-
ilar to the filters in the Alarm program.

Filters can be applied to operators, calendars and periods within a calendar. The priority of filters is as fol-
lows:

1. Filters used in calendars

2. Filters used in periods

3. Filters used on operators

Therefore if you use a filter, filtering out all alarms except flow alarms at the calendar level (in the demo
configuration flow objects starts with q), it doesn’t matter if an operator has no filter, he will only receive
the flow alarms.

For help creating filters please refer to the What’s this help, the scenario concerning filters or click here to
see the help topic from the Alarm help file.

6.5 Operator Groups Scenario

This scenario is an expansion of the simple scenario. We create 4 more operators and some operator
groups.

The scenario goes through the following:

l Creating 4 operators

l Creating 3 operator groups

l Create a weekly calendar for the operator groups

 To go to the next step click the Next button.

6.6 Operator Calendars Scenario

This scenario is a further expansion of the Holidays & Special Periods Scenario. We now expand the cal-
endar to reach beyond the standard week, taking holidays and special periods into account.

The scenario goes through the following:

l Creating 3 operator calendars and making them default

 To go to the next step click the Next button.

alm.chm::/define_a_new_filter.htm
alm.chm::/define_a_new_filter.htm
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Chapter 7: Calendars

7.1 Calendars

The calendars are used by WinPager at any point in time to determine whereto (if anywhere) alarm mes-
sages should be sent. The following three time specifications are used: Weekly calendar, Special periods
and Holidays. The Holidays specification is included in the weekly calendar as one of the calendarperiods.
Click here to learn more about Holiday periods.

As a subtype of the weekly calendar you can create operator calendars, that is a calendar for each oper-
ator. This is an advantage if the operator schedules overlap.

WinPager uses the following priority of the calendars:

Special Periods

Weekly Calendars

Operator Calendars

Click the calendar type to learn more about it.

7.2 Weekly Calendars

A weekly calendar consists of one or more non-overlapping weekly periods. The duration of a weekly
period is defined relative to weekdays – e.g. a period could begin on Mondays at 17.00 and end on Tues-
days at 6.30. For each period the operators which should receive alarm messages has to be selected by
dragging them onto the destination list operator. Instead of using individual operators one of the previously
defined operator groups can be dragged onto the destination list.

To cover a whole week with a single period use the same time as start and stop (e.g. Monday at midnight).

Several weekly calendars can be created. One of the weekly calendars has to be set active (i.e. the one to
use by WinPager).

7.3 Holidays

Any number of individual dates can be defined as a holiday. On these dates WinPager will use the holiday
periods from the weekly calendar. If on a holiday and no holiday periods have been defined in the active
weekly calendar, no alarm messages will be sent during the day.

7.4 Special Periods

In contrast to weekly periods the duration of a special period is defined using absolute time. With this type
of period special events which occur at a specific time and requires alarm messages to be sent to specific
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operators (or suppressing delivery of alarm messages) can be handled. If special periods have been
defined, they will always take precedence over weekly periods (and holidays).

7.5 Print Calendar

With the Print Calendar functionality you can print an operator specific calendar based on the active
weekly calendar. Special Periods and Holidays are taken into account in the Print Calendar func-
tionality. By using this functionality the operators can get a specific calendar, for a user defined time span,
with start and end time, and their role in each period within the time span.

Note: If the weekly calendar has a period with a group instead of individual operators, the operator role
will not be defined.

In the Print Calendar dialog box you select a start time, end time and an operator.

7.6 Holidays & Special Periods Scenario

This scenario is an expansion of the Operator Groups Scenario. We now expand the calendar to reach
beyond the standard week, taking holidays and special periods into account.

The scenario goes through the following:

l Creating 3 holidays

l Creating 1 special period
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 To go to the next step click the Next button.

7.7 Calendar Object

Changing Calendar via SMS Scenario

In this scenario we expand theWinPager configuration of the IGSS demo configuration.

The scenario goes through the following:

l Create an ovl file.

l Check that the CalendarObject is set up correct, on the calendar tab inWinPager.

l Change theWinPager calendar via sms.

If you use another configuration than the demo configuration, click here to learn how to create the calendar
object.

To go to the next step click the Next button.

../../../../../Content/main_95_creating_the_calendar_object.htm
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Chapter 8: Preferences

8.1 Preferences

In the Preferences menu, you can activateWinPager. You can also define various settings such as
event log settings, general settings, special messages, suppression list management and SMS format.

For further details refer to the What’s This help clicking the and then on the element you want help for.

8.2 Suppression List Management

Technical overview

This function allows you to suppress both individual alarm numbers and a series of alarm numbers from
being dialed out byWinpager.

The illustration below shows the steps involved in suppressing alarms. It is recommended to go through the
scenario of use – Creating and using alarm suppression lists – to get familiar with the functionality.

../../../../../Content/alarmsuppressionlists_creating_and_using_alarm_suppression_lists_step_1_of_5.htm
../../../../../Content/alarmsuppressionlists_creating_and_using_alarm_suppression_lists_step_1_of_5.htm
../../../../../Content/alarmsuppressionlists_creating_and_using_alarm_suppression_lists_step_1_of_5.htm
../../../../../Content/alarmsuppressionlists_creating_and_using_alarm_suppression_lists_step_1_of_5.htm
../../../../../Content/alarmsuppressionlists_creating_and_using_alarm_suppression_lists_step_1_of_5.htm
../../../../../Content/alarmsuppressionlists_creating_and_using_alarm_suppression_lists_step_1_of_5.htm
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Alternatives to suppression lists in Supervise and Alarm

Apart from the alarm suppression list function, the operator can use two other functions for suppressing Win-
pager alarms during supervision.

In Supervise
Click on an object and select Inhibit Alarms. In the dialog box, select the check box Inhibit Winpager
dialing. This will inhibit Winpager processing of all alarms on this object.

Show picture

In Alarm
Right-click an alarm for the object for which you want to inhibit Winpager processing of alarms. Select
Inhibit Winpager in the menu.

Show picture

In both cases, alarm number 93 “Winpager Inhibit” is generated for the selected object. To activate Win-
pager processing again, repeat the above procedure, but clear the check box in Supervise or select the
Inhibit Winpager menu item again in Alarm. The alarm is now ended and disappears from the Alarm
List.

Suppression of alarms with alarm filters

Another alternative to the alarm suppression list is to apply an alarm filter to the relevant cal-
endar/period/operator. In the Operators menu, select Filters to create an alarm filter.

The example below shows a filter that will suppress alarm numbers 106-108. Notice that the filter condition
has been negated by selecting the check box Not.

Show picture

When the alarm filter has been defined, simply select it for the relevant calendar/period/operator.

Show picture

../../../../../Content/alarmsuppressionlists_inhibit_winpager_dialing_in_supervise.htm
../../../../../Content/alarmsuppressionlists_inhibit_winpager_dialing_in_supervise.htm
../../../../../Content/alarmsuppressionlists_inhibit_winpager_in_alarm.htm
../../../../../Content/alarmsuppressionlists_inhibit_winpager_in_alarm.htm
../../../../../Content/alarmsuppressionlists_suppress_alarms_using_a_filter.htm
../../../../../Content/alarmsuppressionlists_suppress_alarms_using_a_filter.htm
../../../../../Content/alarmsuppressionlists_alarm_filter_selected.htm
../../../../../Content/alarmsuppressionlists_alarm_filter_selected.htm
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Chapter 9: Control IGSS Objects with SMS

9.1 Overview - Control IGSS objects with SMS

WithWinpager it is possible to allow specific phone numbers to control specific objects in the con-
figuration. This is very useful for the operator, if he receives an alarm from Winpager and knows exactly
how to correct the problem by regulating the process.

The illustration below gives a technical overview of the functionality. It is recommended to go through the
Control Objects with SMS Scenario first to get familiar with the function.

 Two dial-in services are supported: Dial-in (GSM) and Dial-in (Siemens M20/MC35/TC35).

For each object and atom you want the operator to be able to control, a control definition is made.
Only the specified phone number will be allowed to send the command. Batch operations on mul-
tiple objects are also possible (see the Control Objects with SMS Scenario).

 The content of the SMS message must conform with the control definition. Both GSM and Unicode text
formats are supported.

 The Dial-in (Siemens M20/MC35/TC35) service can be used for both acknowledging alarms and con-
trolling IGSS objects via SMS.

 Check the Winpager log window if the requested command is not successful. The log file itself can also
be opened in a text editor. The Winpager.log file is located in the [IGSS InstallPath]\Gss folder.
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9.2 Control Objects with SMS Scenario

As we know already, Winpager will allow an operator to acknowledge an alarm, if a dial-in service is ena-
bled. But in some cases, the operator will also know exactly how to regulate the process to correct or mini-
mize the effect of the alarm he received on his cell phone.

In that case, you can set up Winpager to allow specific phone numbers to control specific objects in the con-
figuration.

In this scenario, you will learn how to:

l Send a command to a digital object (p1)

l Change the setpoint of an analog object (t1)

l Control multiple objects with one SMS message (both objects above)

Note: You can control the following object types via SMS: Analog, digital, counter and table objects. String
objects are not supported.
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The scenario is based on objects found in the IGSS Demo configuration.

9.3 Using .ovl files for controlling objects

l The file must follow the exact syntax below.

l The .ovl file has to be located in the configuration’s report folder.

l It doesn’t work on string objects.

The .ovl file is a phone number specific file, which allows the user to change values or states of several
objects in one operation.

Filename

The file has to have the same name as the number of the phone from which the message is sent, so if the
message is sent from +4512345678, the .ovl file has to be named:

4512345678.ovl

The country code has to be included, but only the numbers, not the ‘+’ sign.

Syntax

The file is made in Notepad or in a similar text editor. In the text file you list the objects, the values of
which will be sent in the SMS message, in the following syntax:

objectname@area,atom,position,length

Where:

l position is the position in the SMS

l length gives the length of the number in the SMS located at the given position, i.e.:

Example of an .ovl file

The picture below shows an example of an .ovl file.

l The object names are case sensitive.

l For analog objects the actual value is atom number 2, for digital objects the state value is atom number 1 and for counter
objects the counter is atom number 1.
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If you send an SMS from 4512345678 to WinPager containing the following information:

1.3 2501

l q1 will be set to 1.3 (the decimal point has to be written with a dot)

l q3 will be set to 25

l p1 will be set to 0

l p2 will be set to 1
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Chapter 10: Reference and Lookup

10.1 File types in Winpager

The following file types exist inWinpager.

Click on the filename for further details.

File extension Filename Short description

.asl [OptionalName].asl Alarm suppression list file. The file contains the
alarm numbers that can be suppressed for cal-
endars, periods and operators.

.atm [PhoneNumber].atm The file contains IGSS objects that can be con-
trolled via SMS. The control definitions are set up
in the Winpager Object Browser.

.log Winpager.log The Winpager event log.

.ovl [PhoneNumber].ovl The file contains IGSS objects that can be con-
trolled via SMS. The file is also used for changing
the active calendar via SMS.

.reg HKEY_LOCAL_MACHINE\SOFTWARE\

7 Technologies\IGSS32\V7.00.00\WinPager
The Windows Registry branch where the Winpager
settings are saved when you convert settings from
an older version of IGSS.

.xml [MyConfig].winpager.xml Winpager configuration file. All settings defined

10.2 Getting Help in IGSS

IGSS comes with a comprehensive help system designed to help both system designers and operators to
get started with IGSS as quickly as possible.

Documentation overview

The IGSS documentation includes the following items:

Documentation item Description

Getting Started

An introduction to IGSS and its most fundamental terms and features.
Getting Started is intended to get you up and running as fast as pos-
sible. The manual provides a system and architecture overview fol-
lowed by a number of real-life use cases you can go through before
building your first real IGSS project. The manual is available in Adobe
Acrobat format (.pdf).

Module help

For each module there is a help file with the same name as the module
itself, for example, Igss.chm for the Master module, Igss.exe.

The help file is invoked by clicking the in the upper right corner of
the module. The Table of Contents will then allow you to browse
through the topics.
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Documentation item Description

Dialog box help

For each dialog box there is a help topic with the following standard
information:

l Overview

l Preconditions

l Where do I find it?

l Field help

Dialog box help is invoked by clicking the help button in the upper
right hand corner of the dialog box.

Thematic help

IGSS also provides thematic help. When there is a special theme that
requires special attention from the user, a dedicated help file is pro-
vided. Examples include "Driver-Specific Help" and "Database Admin-
istration Help".

Where are the help files located?

The IGSS help files are located in the appropriate language folder under the [IGSS InstallPath]. The help
files are available in English at release time.

The paths to the help files are:

Language Path

English [IGSS InstallPath]\ENG

Danish [IGSS InstallPath]\DAN

German [IGSS InstallPath]\DEU

Translated help files

Selected help files have been translated into Danish and German. If you require help files in your language,
please contact 7T.

Help updates

The IGSS help files are continuously updated and improved. Check regularly with the IGSS Update mod-
ule in the IGSS Start menu.

10.3 Conventions in this Manual

The following typographical conventions are used:
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Convention Description Example

User inter-
face ele-
ment

When referring to labels and names
in the user interface.

The Data Management tab.

User input
When the user has to type specific
data in IGSS.

Type the following description:

Incoming flow in Tank 2

Module
name

When referring to a module in IGSS Open the Definitionmodule.

Note

A note emphasizes or supplements
important points of the main text. A
note provides information that may
apply only in special cases.

By default, the timestamp is in universal time
format, UTC1. This can be changed in the
Driver Log Filters dialog box.

Tip

A tip suggests alternative methods
that may not be obvious in the user
interface. A tip also helps the user in
working more effectively with IGSS.
A tip is not essential to the basic
understanding of the text.

Alternative to this simple find
function, you can also filter on
text in the messages in Driver
Log Filters dialog box.

Warning

A warning is an important note that is
essential for the completion of a
task. In some cases, disregarding a
warning may result in undesirable
functionality or loss of data.

If you disregard the System
alarm, you may risk loss of
data in the LOG and BCL files.

10.4 Version Information (IGSS Help System)

© 7-Technologies A/S, IGSS Version 9.0

The IGSS help files are based on software build number 10305 (initial release)

English help files

To update the help files, you must activate the IGSS Update module in the IGSS Start menu. There must
be a connection from the PC to the Internet. Every time IGSS Update is run, IGSS help files as well as
IGSS system files will automatically be updated on the PC from the 7-Technologies web server.

You select the languages you want to update in the Tools menu of the IGSS Update module.

1Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating time in
most parts of the world. IGSS uses this time format internally in the database. You can switch between UTC
and local time by enabling or disabling the "UTC" field in various dialog boxes in the system.
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If you are not able to update the IGSS system directly via the Internet, the alternative is to download the
updates from the 7-Technologies website as zip files. These can then be transferred onto a CD or USB mem-
ory stick, which is then the medium used to update on site.

After running IGSS Update, the build numbers in various IGSS modules may change to a higher
number. This signifies that the module in question has been updated with newer files. Build numbers
consist of four digits, where the first digit represents the year and the last three represent the day
number in the year in question. The build number can be seen in the About dialog box which can be
activated from the Helpmenu.

An example:

Build number = 10305
10 = the year 2010
210 = The 210th day of the year



Chapter 11: Glossary

A

Application menu
The Application menu is the first ribbon in the IGSS Master module. Click the icon to drop
down the menu. The menu contains items that were typically found in the File menu in pre-
vious versions of IGSS. In most modules, an "Options" item allows the user to define global
module settings. The Application menu was introduced in the Microsoft Office 2010 pack-
age. It replaces the Application button (nicknamed Doughnut) which was introduced in IGSS
V7 and V8.

D

descriptor
A descriptor is the graphical display of an object. IGSS includes many types of descriptors
including: - Built-in standard symbols - Animated symbols (Symbol Factory library) - Graph-
ics and animation - Drawing symbols - Windows controls - ActiveX controls An IGSS object
can be represented with different descriptors on different diagrams.

Q

Quick Access Bar
You can customize the Quick Access Bar to include the functions you use most frequently.
Simply drag the relevant function from the ribbon to the Quick Access Bar.

R

Ribbon
The Ribbon is a new term/element in the Microsoft universe. The Ribbon replaces the well-
known toolbars in applications. The Ribbon provides quick access to the most commonly
used functions in the application. The Ribbon is divided into logical groups (the tabs) and
each tab is divided into sections (the blocks in the tab). The Ribbon is context-sensitive
which means that only relevant functions are accessible dependent on the current user
action.

S

SCADA
Supervisory Control & Data Acquisition

U

UTC
Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for cal-
culating time in most parts of the world. IGSS uses this time format internally in the data-
base. You can switch between UTC and local time by enabling or disabling the "UTC" field in
various dialog boxes in the system.
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